
Menu Item:    Sort By Type
What does it do?
This command is used to sort files in your source directory by file type.

Where do I find it?
It is located under the File menu

How do I use it?
Open the directory that you want to sort and click on "Sort by Type".    The files will now be sorted 
alphabetically by file type.



Click here to close out of this window and return to the main file window.



How to:    Use a Mac disk
MacOpener allows you to use a variety of Macintosh disks on your PC.    With MacOpener you can:

Use Macintosh Floppy Disks
Use Macintosh Removable Cartridges and CD-ROMs



Using Mac disks within MacOpener
When you install MacOpener you will have the ability to use Macintosh floppy disks through the 
MacOpener program.    To use a Macintosh disk, simply view the disk from either the Source or 
Destination window (depending on the direction you are copying files).    This is done by going to the 
"Drives" level in the upper window and then selecting your floppy disk drive.



Manual installation of the device driver
To install the device driver in your CONFIG.SYS, type:

DEVICEHIGH=C:\MACOPEN\MO.SYS A: 
Note:    This assumes that MacOpener is installed in the MACOPEN directory on the C Drive and your 
floppy drive is A.    If this is not the case, make the appropriate substitutions.

To install device driver in your AUTOEXEC.BAT, type
PATH=%PATH%;C:\MACOPEN
LOAD-MO

Note:    This assumes that MacOpener is installed in the MACOPEN directory on the C Drive.    If this is 
not the case, make the appropriate substitutions.    Also, if your AUTOEXEC.BAT automatically runs 
windows, make sure that these lines appear before the Windows command line.    



Formatting a Macintosh disk
You can format Macintosh disks either from within MacOpener or from the File Manager, DOS or any PC 
program.
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You can find your MacOpener registration and Version number by choosing About from the Help menu.



Formatting Mac disks using the MacOpener device driver
You can only use this method to format Macintosh Floppy Disks using the MacOpener device driver and 
Windows 3.1, you must format Macintosh removable cartridges through the MacOpener interface.    To 
format a Macintosh Floppy Disk using the device driver portion of MacOpener, you will need to format the 
disk from within DOS.    To format the disk, go into the MacOpener directory, place the disk in your floppy 
drive and type "FORMATM".    You can only format a Macintosh Floppy Disk while in DOS and not from 
the DOS prompt within Windows and the disk must have been pre-formatted as either a Macintosh or a 
DOS disk. 



How to: Format Mac disks within MacOpener
To format a Macintosh disk from within MacOpener, go to the Disk Menu and select "Format a Macintosh 
Disk".    A dialog box will appear that will allow you to format any of your disks (both Floppy and SCSI 
Cartridges) as Macintosh disks.    Simply choose the drive letter that contains the disk you would like to 
format.    When formatting a Macintosh Disk, the disk must have been previously formatted as a PC or 
Mac disk. 



ASPI for Windows:    Advanced SCSI Programming Interface.    MacOpener only recognizes SCSI devices
using ASPI for Windows compliant drivers.    ASPI has become the standard for SCSI communication in 
the industry and most drive manufacturers are now supporting ASPI for Windows.    If you are unsure if 
your device drivers support ASPI for Windows, call the drive manufacturer.



Data Fork:    That portion of the Macintosh file that houses actual content of the file.    Most Macintosh 
programs store files created by users entirely in the data fork.



The directory where you choose to copy the source file to.



PC Extension:    This is the three letter extension that enable PC programs to easily identify a file and 
open it in that program. 



Resource Fork:    That portion of a Macintosh file or application that houses such information as dialog 
boxes, items, cursors, icons, etc.    These items are stored separate from the data fork for easy access 
and maintenance.



SCSI Disks: Small Computer Systems Interface disks.    Any disk that is created on a Macintosh that is not
a floppy disk is a SCSI formatted disk.    This includes Macintosh Bernoullis, Syquests, Zips, EZ 135 and 
most CD-ROMs.

Related Topic:
ASPI for Windows 



The directory containing the file or files you wish to copy.



The file being copied.



Temp Drive:    This is a drive that you only plan to use for this "session", it is not a permanent part of your 
system setup.



Translate (or convert):    To change the underlying structure of a file so that it can be used in another 
format .



How to: Assign SCSI Devices
Although your Operating System assigns drive letters to your SCSI Devices when it boots up, MacOpener
does not know which letter has been assigned to the SCSI Device.    Before using Macintosh SCSI Disks, 
you must Assign SCSI drives to    these devices so that MacOpener can associate a drive letter with each 
of your SCSI Devices.    This is done by choosing "Assign SCSI Drives" under the Disk Menu.

When you choose to "Assign SCSI Drives", MacOpener will communicate with all ASPI for Windows 
compatible devices on your computer.    When MacOpener finds your ASPI for Windows compatible 
devices, it will list all available devices in the SCSI Setup Window.      For each device found, MacOpener 
will list the Host Adapter ID, SCSI ID, Device Name, and the Drive Letter (or "Unassigned") that is 
currently associated with each device..      

To change the assignment of a SCSI device, click on the device name and click <Add/Edit>, you will 
make changes and additions in the SCSI Drive Add/Edit Window.

In this window, you can assign a drive letter to the SCSI device you have selected.    MacOpener will list 
all drive letters available for you to choose from.    You should choose the drive letter the operating system
has assigned to the device, which is the drive letter you use to access PC disks in the SCSI Device.    

You also have the option to assign the SCSI Device to a "Temp Drive" (this can occur when you hook a 
Macintosh hard drive to your PC).    This should be used if the Operating System has not assigned the 
SCSI Device a drive letter.    The "Temp Drive" will only be available for the current MacOpener session.    
In this case you will be able to access the SCSI device through MacOpener by its name in the Select 
Files Window.

If MacOpener does not find any ASPI for Windows compatible devices, you will be get a message 
notifying you of the problem.    If this occurs, you may want to contact your drive manufacturer to make 
sure your device is ASPI for Windows compatible.



How to contact DataViz Inc.
DataViz Inc.
55 Corporate Drive
Trumbull, CT 06611

Sales

Phone: 800-733-0030

Fax: 203-268-4345

e-mail: info@dataviz.com

Web: http://www.dataviz.com

Hours: 9:00 AM to 6:00 PM EST, Monday through Friday

Tech Support

Phone: 203-268-0030

e-mail: techsupport@dataviz.com

Web: http://www.dataviz.com

Hours: 9:00 AM to 6:00 PM EST, Monday through Friday

To help us serve you please have the following information:

1. Registration number and version of MacOpener

2. Version of Windows.

3. Describe the problem in detail.    If you received an error message write down the exact 
message.    What were you doing when the error message occurred?



How to:    Copy File(s) to the PC
To copy a file or files:

1. Choose the directory and file(s) you would like to copy from the Source side of the Select Files 
window.

Double click on the Drives icon in the upper left window to view all disk drives visible to your PC.   
Select the drive and directory where your file(s) are located and from the bottom window select 
the source file(s) to copy.    If you would like to see directories in the bottom window, simply select 
"Batch Processing" from the options menu.    

2. Choose the destination directory from the Destination window.

Double click on the Drives icon in the upper right window to view all disk drives visible to your PC.
Select the drive and directory where you would like to place the file to be copied.    Make sure the 
directory you have selected is open.

3. Hit the Copy button

MacOpener will now take you through the process of copying the file.    If you have not set your 
preferences ahead of time, the product will stop and ask you what name(s) you would like to 
assign the file(s).



How to: Create a Directory
MacOpener gives you the ability to create a directory directly from within the program.    This command is 
located in the Select Files Window, in the Destination side of the window.    To use it, select the place you 
would like to create your directory form the destination side of the Select Files Window and click <Create 
a Directory>.



How to: Delete a file
This command is located under the File Menu, it allows you to delete files from any Source disk that you 
are viewing.    From the Source window, simply highlight the file(s) you would like to delete and from the 
File menu select delete.



How to: Get Information on a File
In the Select Files window, you can choose to get additional information on files by clicking on the "File 
Info" button.    When you choose this option, MacOpener will display the file information on the selected 
files.    You will see information on the file including the program that it was created in, the size of the file, 
the modification date and time, the type and creator (if it is a Macintosh file) and the three character PC 
Extension.    You can sort the files by category simply by clicking on the heading of that particular 
category.    The heading underline and blue text tells you by which category the files are sorted.

In some cases there may be a * next to the file size.    This means there is a resource fork in the file. 
When copying files with MacOpener both the data fork and resource fork of the file will be retained.    After
looking at the file information, you can copy the file(s) to your desired location by selecting the file(s) you 
want and clicking <Copy> or return to the Select Files window by clicking <Cancel>.

Related Topics:
Macintosh File Structure



How to:    Install MacOpener Device Driver
From within the MacOpener program you can read and write Macintosh disks.    In most situations, 
Macintosh files require copying.    The most convenient way to copy files at the same time is from within 
the MacOpener interface.

There are some situations where you might want to view and format Macintosh Floppy Disks through the 
File Manager, DOS or any Windows programs.    To do this you must install the device driver (MO.SYS), it 
is easiest to do this by using the MacOpener installer.    

You can avoid using the installer by adding a line manually to your CONFIG.SYS or AUTOEXEC.BAT. 

To install the MacOpener device driver:

1. Run the MacOpener installer.

2. Click Custom install.

3. The installer will prompt you to install the MacOpener device driver.    Follow the on screen 
instructions.

4. You will have the option to install the device driver in either your CONFIG.SYS or your 
AUTOEXEC.BAT file.

Install the MacOpener device driver in your 
CONFIG.SYS if any of the following apply:

You would like the MacOpener device driver 
to load into high memory rather than 
conventional memory

The drive letter immediately following your 
hard drive is available and not used by a CD-
ROM, Network, etc.

Install MacOpener device driver in your 
AUTOEXEC.BAT if any of the following apply:

You don't need the MacOpener device driver 
to load into high memory.

The drive letter immediately following your 
hard drive is not available because it is used 
by a a CD-ROM or Network.



How To:    Preview Text and Graphic Files
MacOpener gives you the ability to preview Macintosh text and graphic (PICT and EPS) files before you 
copy them.    You can choose to preview a batch of files or just one file at a time.    Batch file views are 
especially helpful when you have a number of files and are not sure what they look like    To preview files 
you should:

1. Choose the source file(s), from your Source location in the Select Files Window.

You can select multiple images by holding down the control key and clicking on each of the files.   
Please note when previewing multiple files, all the files to be previewed must be located in the 
same source directory.    

2. Click the Preview button.    This will bring you to the Preview screen.

If you have selected multiple files you will have the ability to move through the images you have 
selected by clicking on the "Next" button.

If you would like to copy the file(s) you can do so from the Preview screen.



Menu Item: Auto Launch
What does it do?
MacOpener allows you to map a program associated with the file you are copying.    If activated, after the 
file has been copied, MacOpener will automatically launch the program and open the file.    

Where do I find it?
This command is found under the Options menu. 

How do I use it?
It is a toggle switch that is (de)activated by clicking on it.    You must have the program loaded on your 
machine in order to launch it.    If MacOpener can not find your program you will be prompted to enter a 
command line which identifies the location of that program.

Related Topic:
File Formatting and Extension Mapping



Menu Item: Clear Log
What does it do?
The Log menu gives you an activity account of the product during installation and during a transfer.    
Entries are automatically entered to the log by the MacOpener program.    These entries normally contain 
the date, time, file name, and a description of any errors or warnings.    The Clear Log command clears 
the present log of all previous information.

Where do I find it?
This command is found under the log menu. 

How do I use it?
Simply click on the command and the log will be cleared.



Menu Item: Clear Settings
What does it do?
This command is used to clear previously saved settings, and will return the product to its last 
configuration.

Where do I find it?
This command is located under the Options menu. 

How do I use it?
Simply click on the item and your settings will be cleared.



Menu Item: Delete
What does it do?
This command is used to delete files from your Source directory.

Where do I find it?
It is located under the File menu

How do I use it?
To delete files first highlight the files you would like to delete in your Source window and choose File 
Delete.    You will get a message asking you if you are sure, click OK.



Menu Item: Exit
What does it do?
This command will allow you to Exit out of the MacOpener program.

Where do I find it?
The Exit command is available from the File Menu.

How do I use it?
Simply click on the item and MacOpener will quit.



Menu Item:    Extension Mapping
What does it do?
This command allows you to add or edit an extension in the MacOpener Extensions Database.

Where do I find it?
This command is located under the Options menu. 

How do I use it?
Click on Extension Mapping and you will be brought to the Extension Mapping window.    Once in this 
window, click "Add", or highlight a format and click "Edit" (Note:    You can only edit formats that you have 
previously added to the database and not formats that shipped with MacOpener), this will bring you to the 
User Format Add/Edit window .



Menu Item: Save Settings
What does it do?
This command is used to "Save" a snapshot of the session in which you are presently working.    It allows 
you to save your present location, direction, file control settings, and auto launch status.    

The next time you use the MacOpener program, it will start with the settings that were in effect when the 
defaults were saved.    If you do not save your settings, the program will remember the configuration you 
last had in place when you exited MacOpener and start with that configuration in place.    

Where do I find it?
It is located under the Options menu.

How do I use it?
Simply click on the command and your settings will be saved.



Menu Item:    Sort By Name
What does it do?
This command is used to sort files in your source directory by name.

Where do I find it?
It is located under the File menu

How do I use it?
Open the directory that you want to sort and click on "Sort by Name".    The files will now be sorted 
alphabetically by name.



Multipacks and site licenses
MacOpener is available in Multipacks of 5, 10, 30, and 100.    Contact DataViz and ask about our 
discounted pricing to upgrade your copy to multiple copies.

Site licenses are also available when more than 100 copies are needed.



Other DataViz Products
For Windows users:
Conversions Plus is a Windows utility that lets you use Macintosh disks and translate files between 
different programs.    

MacLinkPlus is our Macintosh line of products that allows you to use PC disks in your Macintosh and 
convert files between different programs.



Copy Methods
When moving files via "Text" MacOpener will reconcile discrepancies between Macintosh and PC text 
files.    Moving a file using the "Binary" method is simply moving the file bit by bit as it is.

The "MacBinary" method of transfer has been developed to allow complete Macintosh files (the data fork 
and the resource fork) to be moved to non-Macintosh computers.    When using MacBinary as a copy 
method, the data fork and resource fork of a Macintosh file are stored together in a single file.    This is 
useful when you are transferring Macintosh files over PC volumes as it prevents the loss of any 
information .    If the "Binary" method is used on a file with both a data fork and resource fork, the 
information in the resource fork will be lost.

When a file is brought over and stored in a "MacBinary" format on a non-Macintosh computer, it is 
encoded.    When moving the file back to the Macintosh, MacOpener will use the MacBinary copy method 
to decode the file properly so that all the file information remains intact.

Related Topics:
PC Text vs. Macintosh Text
Macintosh File Structure



The difference between Disk Format and File Format
All computers are not designed alike.    Therefore programs, files, and disks cannot be easily shared by 
different types of computers.    This is the reason MacOpener was created.

On the PC, DOS and Windows use the same DOS format for initializing disks, maintaining directories, 
naming files and storing them on diskettes.    A different structure with longer file names and more 
directory information about each file is used by the Macintosh system software.    In other words, the disk 
format, or the way files are stored on the disk is different for PCs and Macs.

A file's format, or the way the information is organized within the file, is generally unique to the program 
that created it.    This is the case whether the disk format is DOS or Macintosh:    a file from program X is 
the same file, whether it is on a hard disk, a floppy disk or a network file server.

When different programs are being used on the PC and Mac, these file format issues become an 
obstacle.    MacOpener removes this obstacle by providing the capability to copy a file.    



File Formatting and Extension Mapping
Every file contains information which helps identify its format.    This information is stored differently on a 
Macintosh than it is on a PC.    Macintosh files are identified by their type and creator , while the PC files 
are identified by their 3 character PC extension.    When moving files between Macs and PCs, this file 
information is normally lost.    MacOpener will preserve this file information using a technique called 
Extension Mapping.

Extension Mapping is the process of keeping the appropriate file information when moving files across 
platforms.    When moving a file from a Macintosh to a PC, MacOpener will look at the Macintosh file type 
and creator and assign the appropriate PC extension (hence, the name Extension Mapping).    
Conversely, when moving a file from a PC to a Macintosh, MacOpener will assign the appropriate file type
and creator.    For example, when moving a Microsoft Word document from the Macintosh to the PC, 
MacOpener will automatically put a .DOC extension on the file.    This extension helps Word for Windows 
recognize and open the document.      

MacOpener ships with a database of PC extensions and their corresponding Macintosh types and 
creators.    There may be situations, however, where certain programs are not included or where new 
programs have been released.    For these situations, MacOpener gives you the option to add new entries
into the Extension Mapping Database.    This can be done by selecting "Extension Mapping" from the 
Options menu. 

Related Topics:
Macintosh File Structure
How do I?    Get PC programs to recognize my Macintosh files 



MacBinary
MacBinary is a format in which the data and resource fork of a Macintosh file can be stored together in a 
single file.    This is useful when you are transferring Macintosh files over PC volumes as it prevents you 
from losing any of your file information.    A MacBinary file consists of the data fork, the resource fork and 
some additional information describing the two components.    MacOpener will let create a MacBinary file 
when copying from a Mac to a PC and will expand a MacBinary file when going PC to Mac.



Macintosh File Structure
The Macintosh has a unique file structure, that differs from the PC (or any other computer) in the following
ways:

1) Each file can have a data fork, a resource fork, or both.    Usually, Macintosh programs have a 
resource fork with no data fork, and files created by those programs (such as word processing documents
or spreadsheets) have a data fork and no resource fork.    This is not always true, but it is true much of the
time.    The data fork of a file is equivalent to an entire file on the PC, since the PC does not support the 2-
part file concept.    There is no equivalent to a resource fork on the PC.

2) Every file has certain attributes associated with it.    On the PC, the file attributes are it's date, 
time, and size.    On the Macintosh, files have more attributes associated with them than PC files, two of 
the most important are called type and creator.    The type indicates to that Macintosh program whether 
the file is a document, a dictionary, a preference file, etc. and the creator identifies which program created
the document.    These can be thought of as a more descriptive version of the PC file extension (which 
can be used to identify the type of file and program that created it).    The Macintosh file attributes are 
stored in the Volume Information Block (VIB), the equivalent of the PC's File Allocation Table (FAT).

Related Topics:
PC Text vs. Macintosh Text
Copy Methods



Menus
File menu

Delete
Sort By Name
Sort By Type
Exit

Disk menu
Format Mac Disk
Assign SCSI Drives

Options menu
Auto Launch
Batch Processing
Copy Method
File Naming
Extension Mapping
Save Settings
Clear Settings

Log menu
View Log
Clear Log



MacOpener Windows
Click on any window below to learn more about it.

Select Files Window - This is the main MacOpener window. 
File Information Window - This is the window that appears when you request information on a 
file(s).
Extension Mapping Window - This is the main Extension Mapping window.
Format Add/Edit Window - This window is used to add/edit formats to the Extensions Database



PC Extensions List
This is a summary of the common file extensions you may see on a PC disk.    In many cases, these 
extensions are required or expected by the application.    In other cases, they are common usage but are 
not required.

.BAK Backup file 

.BAS BASIC program file

.BAT DOS ‘Batch’ 
command file

.BMP Windows Bitmap 
Graphic

.CVS Canvas file

.CGM Computer Graphics 
Metafile

.COM Executable (binary) 
file

.CSV Comma Separated 
Values

.CWK ClarisWorks

.DBF dBase II, III, IV data 
file

.DIF DIF file (common)

.DLL Dynamically Linked 
Library

.DOC Multimate (through 
v3), MS Word 

.DOX Multimate v4.0 
document

.DXF AutoCad DXF

.EPS Encapsulated 
PostScript

.EXE Executable (binary) 
file

.FMFileMaker or 
FrameMaker file

.FH3 Freehand 3.x

.FH             Freehand 

.GEM Ventura Publisher 
GEM

.GIF Graphics 
Interchange 

Format(CompuServe)
.IMG Ventura Publisher 

IMG
.JPG JPEG Graphic file
.MEM dBase Memory File
.MIF FrameMaker MIF
.MLP MacLinkPlus Print 

Capture file
.OBJ Compiled object file
.PCC PC Paintbrush file
.PCT PICT

.PRN ‘Print’ file

.PUB PageMaker 2.0 file

.QED Quicken file

.QXD QuarkXPress file

.RFT DisplayWrite 
Revisable Form Text 

.RTF Rich Text Format

.SAM AmiPro file

.STY MS Word Style Sheet

.SYL SYLK format 
variations are .SLK, .SK

.SYS DOS system file; 
usually not translatable

.TAB Tab Text

.TGA Targa graphic file

.TIF             TIFF graphic 
file

.TSV Tab Values

.TXT ASCII Text file 
(common)

.WB1 Quattro Pro Windows
5.0

.WB2 Quattro Pro Windows
6.0

.WDB Works Database file

.WKS Lotus 1A or MS 
Works spreadsheet

.WK1 Lotus 2A spreadsheet

.WK3 Lotus 3 (3-D)

.WK4 Lotus 4 & 5 (3-D)

.WMF Windows Metafile

.WP OfficeWriter or 
WordPerfect 

.WPD WordPerfect 
(common); variation 
is .WP

.WPG WordPerfect graphics

.WPS MS Works Word 
Processing document

.WQ1 Quattro Pro DOS

.WRK Symphony 
spreadsheet

.WR1 Symphony 
spreadsheet

.WS WordStar document 
(common)

.XLC Excel chart

.XLM Excel macro

.XLS Excel spreadsheet



.PCX PC Paintbrush file

.PIC Lotus Graphic file

.PM PageMaker file 

.PPT Power Point file

.PRG dBase program

.XLW Excel Workspace

.XY             XyWrite (common)



PC Text vs. Macintosh Text
Text files are represented differently on the Macintosh and the PC.    On the Macintosh , a "return" at the 
end of a line is represented by a carriage return (<CR>) only.    On the PC, the "return" at the end of a line 
is represented by a carriage return, line feed pair (<CR><LF>).    Another difference is the set of 
characters available.    Certain characters on the PC do not exist on the Macintosh, certain characters on 
the Macintosh do not exist on the PC, and certain characters are represented by different ASCII values 
(even DOS and Windows have certain discrepancies in the way they represent characters).    Most of the 
differences in these sets are not with commonly used characters but rather with extended ASCII 
characters.

When moving text files from a Macintosh to a PC, MacOpener will transparently reconcile these 
discrepancies, whenever possible.    It is difficult to tell between the different types of text files.    For 
MacOpener to handle text files as effectively as possible, you will need to identify the method of transfer 
you prefer when moving text files.    You do this by choosing either text, MacBinary or Binary from the 
"Copy Method" under the Options menu.

Related Topics:
Copy Methods



Conversions Plus for Windows
Conversions Plus is a Windows program also produced by DataViz.    It is useful when you are dealing 
with incompatible file formats across platforms or programs.    

Like MacOpener, it gives you the ability to view Macintosh disks and Macintosh SCSI devices on your PC.
However, in addition it gives you the ability to translate files between incompatible programs.    With 
Conversions Plus, you can convert files from popular word processing, spreadsheet, database and 
graphics programs from Mac-to-PC, PC-to-Mac, and PC-to-PC.        

Conversions Plus does more than just move files from computer to computer or program to program, it 
also provides full file translation so you can actually use your files in different programs.    For example if 
you have a Macintosh Microsoft Word file and would like to use it in WordPerfect PC, Conversions Plus 
will convert it.    All the original file formatting is retained, including bold, italics, underline, and embedded 
graphics, so you don't have to retype a thing.    Conversions Plus also allows you to preview graphics files
and convert portions of the images.

DataViz offers all MacOpener customers special upgrade pricing to purchase a full copy of Conversions 
Plus.    For more information contact DataViz.



These buttons allow you to specify what MacOpener should do upon encountering an error.    
This is useful for batch translations.

If Stop and notify me is specified, then MacOpener will notify you any time there is an 
error.

If Skip the file and continue is specified, MacOpener will enter the error in the Log, but 
will not interrupt the process.



Click here to copy the selected files to your destination location.



This column gives you the file format that is associated with the selected files.    Click here to sort the files 
by format.



This column gives you the date and time the selected files were last modified.    Click here to sort the files 
by modified date.



This column gives you the assigned names to the selected files.    Click here to sort the files by name.



This column gives you the PC Extension that is associated with the selected files.    Click here to sort the 
files by PC extension.



This column gives you the file size of each of the selected files.    Click here to sort the files by size.



This column gives you the Macintosh type and creator of selected files.    Click here to sort the files by file 
type and creator.



Use this button to get information on files that our selected in your source directory.



Click the Copy Button to copy a file.    Note: You must select a file from the source directory 
before you can click this button.



Click the Create Directory button to make a new sub-directory within the Destination 
Directory.    MacOpener will create a directory and navigate to it.



Use this window to navigate to the destination directory.    To switch to another drive, double-click on the 
Drives icon.



This window lists, in gray, the files in the destination directory.    The file you are copying will be placed in 
this directory.



The Destination side of the Select Files window allows you to select the location where the 
destination file will be placed and the platform (Mac or PC) to which you want to translate.



Click the Direction Arrow to reverse the Source and Destination sides of the Select Files 
window.



Click this button to preview the Source File prior to copying it.



Click this button to select all of the files in the Source Directory.



Use this window to navigate to the source directory where your file(s) is located.    To switch to another 
drive, double click on the Drives icon.



Select the file(s) you wish to translate from this list.    If the file you want does not appear in the list, you 
may need to specify the source directory in the list immediately above.



The Source side of the Select Files window allows you to select the files to be copied or 
viewed.



MacOpener provides additional functionality that gives you access to a Macintosh Floppy Disk using 
many different methods when you are running Windows 3.1.    In this way MacOpener is used as a device 
driver, which allows you to view disks from within the File Manager, DOS or any PC program.    When you 
are within the MacOpener program you have the ability to view Macintosh disks, regardless of whether 
you have installed the device driver portion of the product.    To view Macintosh disks through any of the 
other methods mentioned you have to install the device driver.     



Menu Item: Format Mac Disk
What does it do?
This command allows you to format a Macintosh disk from within the MacOpener program.

Where do I find it?
It is located under the Disk menu.

How do I use it?
To format a Macintosh disk within MacOpener, simply click on "Format Mac Disk".    From the dialog box, 
choose the drive letter that contains the disk you would like to format.    When formatting a disk in this 
manner, the disk must have been previously formatted as a high density DOS or Mac disk.    



Menu Item: View Log
What does it do?
The Log menu gives you an activity account of the product during installation and during the copy 
process.    Entries are automatically entered to the log by the MacOpener program.    These entries 
normally contain the date, time, file name, and a description of any errors or warnings.    The View Log 
command opens the Log windows and displays the log.

Where do I find it?
It is located under the Log menu.

How do I use it?
Simply click on the command and the log will be presented.    To print the log, simply open the log (a 
standard text file) from within a word processing program and print it.    The name of the file is 
Macopen.log and it is located in the MACOPEN directory.



This option is (de)activated by clicking on it.    When selected, MacOpener will stop on a file format not 
automatically recognized and ask you if you want to add the format to the Extensions Database.



This lists all the formats that our currently in the Extensions Database.



Click this button to add a format to the database.    You will add a format in the User Format Add/Edit 
Window.



Click this button after selecting a format to edit, you will edit the format in the User Format Add/Edit 
Window.    Note:    You can only edit file format information for formats that were added to the database 
(i.e. they did not ship with the product).



Click here after you have selected a file format to delete from the database.    Note:    You can only remove
formats that were added to the database (i.e. they did not ship with the product).



A * will be listed after a file format if it was added by a user rather than shipped with the product.



How to: Use Macintosh floppy disks
You can use Macintosh floppy disks either from within MacOpener or from the File Manager, DOS or any 
PC program (using Windows 3.1).



How to: Use Mac Removable Cartridges and CD-ROMs
If you plan to use Macintosh removable cartridges or CD-ROMs (SCSI Disks) within MacOpener, you 
should follow the same directions as you would for Floppy Disks.    The only difference is that you will 
need to select the drive letter of your SCSI device rather than your A: or B: drive.    Before using 
Macintosh SCSI Disks, you must Assign SCSI drives to these devices so that MacOpener can associate 
a drive letter with each of your SCSI Devices.    

Once you have assigned your drives you can view the disk from either the Source or Destination window 
(depending on the direction you are copying files).    This is done by going to the "Drives" level in the 
upper window and then selecting your SCSI or CD-ROM drive.

If you are using ASPI for Windows compatible drivers, the following SCSI devices are supported in 
MacOpener:

- Syquest Drives
- Syquest EZ 135 Drives
- CD-ROM Drives
- Iomega Bernoulli Drive
- Iomega Zip Drive
- Sony Rewritable Optical Disk Drives
- Macintosh Hard Drives



MacLinkPlus for the Macintosh
MacLinkPlus is the Macintosh product line of utilities, by DataViz, which are similar to MacOpener for 
Windows.    They contain very similar features, yet are designed for the Macintosh user to run on any 
Macintosh (Macintosh Plus or better, including the new Power Macintosh line).    There are three 
MacLinkPlus products, each one "builds" on the next.

The most "basic" product is MacLinkPlus/Easy Open Translators.    This product contains:

- The entire Mac-PC file translation library
Contains all the same translators as Conversion s Plus for Windows

- Macintosh Easy Open
A system extension designed by Apple Computer, which allows for the quickest and easiest file 
translation possible.

- DataViz FileView for the Macintosh

The next product in the line is MacLinkPlus/Translators Pro.    It contains:
- The same features as MacLinkPlus/Easy Open Translators (noted above)
- Macintosh PC Exchange.

A utility from Apple Computer that allows you to put DOS-formatted disks in your Macintosh (including 
floppy disks, removable media, such as Syquest and Bernoulli, and SCSI hard disks).

The most "complete" product in the line is MacLinkPlus/PC Connect.    It contains:

- The same features as MacLinkPlus/Translators Pro (noted above)
- Serial cable and modem communications software

Allows you to physically connect a Mac and a PC and move files back and forth

So, which one do YOU need?

MacLinkPlus/Easy Open Translators:    Best if you need to translate files only.    In other words, you 
already have a way to move the file back and forth from the Mac to the PC (i.e., you are on a cross-
platform network, you already own a "DOS disk mounting" utility, you need to do Mac to Mac conversions 
only).

MacLinkPlus/Translators Pro:    Best if you need to translate files AND put DOS formatted disks in your 
Mac.

MacLinkPlus/PC Connect:    Best if you need to translate files, use DOS disks in your Mac AND actually 
connect your Mac and your PC and move files from one hard drive to the next (i.e., you have very large 
files to move, or you need to send files over a modem). 

Solution for the HP Palmtop computer:
MacLinkPlus/HP Palmtop allows you to convert HP Palmtop (200LX, 100LX and 95LX) files in your 
Macintosh - and vice versa.    You can convert your Macintosh phonebook file (Now Contact, Act!, 
Touchbase, etc.) in the HP PhoneBook.    Or use the appointments from your HP Appointment Book in 
Now Up-to-Date or DateBook Pro.    MacLinkPlus/HP Palmtop also allows you to back up your entire HP 
Palmtop on your Macintosh - with just a click!    MacLinkPlus/HP Palmtop solves all of your file 
incompatibility problems between the Macintosh and the HP Palmtop. 



How to:    Get PC programs to recognize Macintosh files
Files have different structures on the Macintosh and the PC.    On the Macintosh, each file has a File Type
and Creator.    This identifies the format of the file and allows programs to identify the files they support.    
On the PC, programs recognize files by their 3 character PC extension, with each program assigning a 
different extension to a file.    

MacOpener ships with a database of Macintosh File Types and Creators and their corresponding PC 
extensions.    This combination of an extension and a File Type and Creator is referred to as a file format.  
If you are using a file format which is not currently in the MacOpener Extensions Database you have the 
option to add it.

There are two different methods for adding "User Formats" to the database.    One method is to have 
MacOpener prompt you when it encounters a new format.    Using this method the program will 
automatically fill in the File Type and Creator information from the file being copied and you must add the 
PC extension and the file format name you want for that program (this name can be anything you like).    
To use this method, you must choose "Extension Mapping" from the Options menu and within the 
Extension Mapping window, select "Prompt me when encountering a new file type".

Another method is for you to add a new "User Format" to the database.    To do this choose "Extension 
Mapping" from the Options menu and click <New>.    This will bring you to the User Format Add/Edit 
window.    In this situation you will have to fill in all the appropriate file information.    The format name is 
used to identify the entry in the Extensions Database and can be assigned any name you choose.    If you 
are unsure of the File Type and Creator information, you can contact the program manufacturer to get this
information. 

Related Topics:
Macintosh File Structure
File Formatting and Extension Mapping



Troubleshooting tip when the PC can't open a Mac file
There are a couple of    possibilities as to why your PC program can’t open the Mac file you have copied.

1. Some PC programs require a 3 character extension to open the file.    Included with MacOpener is
a feature called Extension Mapping.    This feature places the proper extension on a Macintosh file
so that the PC program will recognize and open the file.    MacOpener ships with a database of 
current programs and their proper PC extensions and gives you the ability to add programs to the
Extensions Database..

2. In order for the file to be opened by the PC program the file must be in a format that the program 
can understand.    Currently, there are many programs on the market that are "cross-platform" 
programs, which means that their file formats are the same.    An example of this is Microsoft 
Word version 6.    If you create a document in Word Macintosh 6 , that document should be able 
to be opened directly in Word for Windows 6 without any difficulties.    If the PC program opens 
the document and it doesn't look good, it is possible that the file needs to be converted.    DataViz 
makes another product, Conversions Plus that provides file translation, allowing you to convert 
documents between different programs.

3. If these steps do not help, contact DataViz.



Troubleshooting tip when the Macintosh can't open the PC
file 
Macintosh files are a different file format then PC files.    Most Macintosh programs require a type and 
creator on every file in order to open it.    You should check the extension mapping of the file format to 
make sure the proper type and creator information has been placed on the file.    If you are unsure of the 
type and creator information needed for that particular format, you should contact the manufacturer of the 
program for the information.    MacOpener ships with a database of many popular formats, however there 
may be some that are not included in the extensions database.    You have the option to add formats in 
the Extension Mapping window.

Related Topics:
Macintosh File Structure



Troubleshooting tip when MacOpener is not recognizing 
my Macintosh floppy disk
If you are not able to read or write to the Macintosh disk, here are some ideas to help work around it.

1. MacOpener only supports high density Macintosh disks.    Check that your Macintosh disk is high 
density, and not double density or low density.    If you are using a low density disk and have 
access to a Macintosh, you can move the information to a high density disk.    Simply go to the 
Macintosh and copy the files from the low density disk to the hard disk and then copy them to a 
high density Macintosh disk      Your Macintosh must have a High Density disk drive, commonly 
referred to as a Super Drive.

2. Check to see if the disk is locked.    If the disk is locked, unlock it.

3. Bring the Macintosh disk back to the Macintosh and see if it can read it (If the Macintosh can't 
read the disk then the disk may be damaged).    If the Macintosh can read the disk, copy the files 
onto a different Macintosh high density disk, and bring it back to the PC.

4. Format a pre-formatted DOS disk as a high density Macintosh disk in MacOpener.    Bring the 
newly formatted Macintosh disk to the Macintosh, and copy the files onto it.    If the Macintosh 
can't read the disk, then one of the disk drives could be out of alignment.    If this is the situation, 
try using a different Mac and PC.

If after trying all of the above steps, you are still unable to solve the problem, contact DataViz Technical 
Support.



Troubleshooting tip when MacOpener is not recognizing 
my SCSI drive
Make sure that you have assigned your SCSI devices to a drive by choosing "Assign SCSI Devices" from 
the disk menu..  When using Macintosh SCSI cartridges, MacOpener can’t always tell which drive letter 
DOS assigned to the SCSI device, so you must enter the appropriate drive letter.    If you just need the 
device for one session assign it as a Temp drive.    If this does not work, contact DataViz.



Troubleshooting tip when you get a message warning you 
that ASPI for Windows is not installed
MacOpener only support SCSI devices that support the industry standard ASPI for Windows .    You 
should contact your SCSI device manufacturer for details on whether or not your device is ASPI for 
Windows compliant.



Troubleshooting tip when MacOpener can’t Format my 
Macintosh disk
If you can’t format a Macintosh Disk, here are some things to try:

1. The Macintosh disk must be a high density disk.    Low density disks can not be formatted as 
Macintosh.

2. The disk must be previously formatted as DOS or Mac.    If the disk is not pre-formatted go to the 
File Manager and format the disk, then come back to MacOpener and format the disk as a 
Macintosh Disk.

3. If these steps do not solve the problem, contact DataViz.



Troubleshooting tip when MacOpener is not showing your 
long PC file names in Windows 95
MacOpener ships with both a 16 bit and 32 bit version of the program.    You need to make sure that you 
installed the 32 bit version of MacOpener.    Go under the help menu to "About MacOpener" and check 
that it says "32 bit version".    If it doesn’t, reinstall MacOpener and select MacOpener for Win95.



Select Files Window
      

What does it do?
This is the main MacOpener window from 
which files are chosen.

Where do I find it?
It is the first window that appears when you 
launch MacOpener.

How do I use it?
Click on the parts of the window where a 
hand appears to get more information about 
each item.



Menu Item:    File Naming
What does it do?
This command allows you to specify your preference for file naming, adding extensions, and the action to 
take in case of errors.

Where do I find it?
This command is located under the Options menu. 

How do I use it?
Simply click the choices you prefer in each circumstance.

For New File Names:    
You have the option to be prompted to assign a new name or simply let MacOpener use the default name.
Assign Extension to New File Name:
You have the option to use the mapped extension (the one which MacOpener has associated with the file), or not to 
modify the extension.
In case of name conflicts:
If you have chosen to have MacOpener assign file names (see above), you have the option to stop on a file name 
conflict or let MacOpener resolve the conflict.    If you choose to let MacOpener resolve the conflict, you must further 
decide if MacOpener should overwrite the existing file or slightly modify the name of the new file.

    



Menu Item:    Copy Method
What does it do?
This command allows you to specify the method of copying a file when moving between a Macintosh and 
a PC.

Where do I find it?
This command is located under the Options menu. 

How do I use it?
Simply click on copy method and choose the method (Binary, Text or MacBinary) you would like 
MacOpener to use when copying files.

Related Topics:
Copy Methods
MacBinary



Using the Device Driver portion of MacOpener
You can use a Macintosh Floppy Disk through the File Manager, DOS or any PC program if you are 
running Windows 3.1(not if you are running Windows 95 or Windows NT).    To do this, you must have 
installed the device driver portion of MacOpener.    Once you have installed the device driver, you will 
have the ability to use the Macintosh Floppy Disk as if it was a regular PC disk.



Menu Item:    Batch Processing
What does it do?
This command allows you to view entire directories in the file portion of the Source window, so that you 
can easily select the directory to be copied.    All directories and sub-directories and the files contained 
within these directories will be copied over.

Where do I find it?
This command is located under the Options menu. 

How do I use it?
Select "Batch Processing" from the options menu and choose your preferences.

Allow selection of directories for copying:
You have the option to copy full directories and sub-directories to or from Macintosh disks.    If you select this option 
directories, as well as files, will show up in the "file selection portion" of the window.    If this option is set, you will not 
be able to preview files.
During a batch process:
When you are copying a batch of files (more than one), you can choose to have MacOpener continue copying 
without interruptions.    If this is set, MacOpener will not prompt you for new Mac formats, will not prompt you for new 
file or directory names, and will not prompt you on directory errors until the batch is finished being copied.



File Information Window
      

What does it do?
This window gives you information on the 
file(s) you have selected.

Where do I find it?
After you have highlighted the file(s) and 
clicked the "File Info" button, you will be 
brought to this window.

How do I use it?
Click on the parts of the window where a 
hand appears to get more information about 
each item.



Menu Item:    Assign SCSI Drives
What does it do?
This command is used to assign your SCSI devices to a drive letter

Where do I find it?
This command is located under the Disk menu. 

How do I use it?
Simply click on the "Assign SCSI drives" and within the SCSI window, click on the device you want to 
assign and click <Add/Edit>.    The window will list all the SCSI devices that MacOpener has found and 
can communicate with.    For MacOpener to recognize your drive, you must assign a drive letter to the 
device(s) which you wish to access.    Choose the drive letter that the operating system (DOS/Windows) 
has assigned to this device, which is the drive letter used to access PC disks in the SCSI Device.    

Related Topics:
How Do I?:    Access Macintosh Removable Cartridges



Extension Mapping Window
      

What does it do?
This window lists all of the file formats 
included in the Extensions Database.    
These formats are used to put the 
appropriate file information on a file 
when copying it between the Macintosh 
disk and the PC.

Where do I find it?
This window appears when you select 
"Extension Mapping" from the Options 
menu.

How do I use it?
Click on the parts of the window where a
hand appears to get more information 
about each item.



Choosing a Partition
Sometimes disks can be partitioned into more than one "logical" disk.    What this means is that there is 
more than one volume on the disk.    When MacOpener encounters a Macintosh disk with more than one 
partition, MacOpener will prompt you to choose which partition you want to open.    You will see the 
volume name of each partition and can only open one partition at a time.    To switch partitions, simply go 
to the "drives" level, choose the disk and click on the other partition. 



Troubleshooting Tips

The PC can't open the Macintosh file I have copied
The Macintosh can't open the PC file I have copied
MacOpener is not recognizing my Macintosh Floppy Disk
MacOpener can’t format my Mac Floppy Disk
MacOpener is not recognizing my SCSI drive
In "Assign SCSI Devices" I get the message, "  ASPI for Windows   is not Installed"  
In Windows 95, MacOpener is not showing my long PC file names
Contact DataViz Technical Support



Adding and editing user formats
What does it do?
This screen appears when you decide to add or edit a format in the Extensions Database

Where do I find it?
Select a file format in the Extension Mapping Window and click either "New" or "Edit".

How do I use it?
You should fill in the appropriate file information for the format.

Format Name:
This is where you assign a format name to correspond to a PC extension and Macintosh file type and creator      For 
example, Word for Windows 6.0, PageMaker 5.0, Excel 5.0.
PC File Extension:
This is where you fill in the three character PC extension.    For example, DOC, PM5, XLS.      
Mac File Type:
This is where the Macintosh file type is entered.    If you have chosen to be prompted when encountering a new file 
format, MacOpener will fill in this information from the Mac file being copied.    If you are entering a new format 
manually, you must know this information and fill it in.    For example, W6BN, ALB5, XLS5.    
Mac File Creator:
This is where the Macintosh file creator is entered.    If you have chosen to be prompted when encountering a new 
file format, MacOpener will fill in this information from the Mac file being copied.    If you are entering a new format 
manually, you must know this information and fill it in.    For example, MSWD, ALD5, XCEL.



Text Preview
The text preview extracts text from different files and displays it.    It is helpful if you need to find a 
particular file and want to learn its general contents.    It is an unformatted, "quick preview" of the file(s) 
you have selected.    From the preview window you can choose to "Copy" the file you have selected or 
preview other selected files using the "Next" and "Previous" buttons.    To return to the main window, click 
"Cancel".



Graphic Preview
The graphic preview allows you to preview Macintosh PICT or EPS (PICT thumbnail) images.    From the 
preview window you can choose to "Copy" the file you have selected or preview other selected files using 
the "Next" and "Previous" buttons.    To return to the main window, click "Cancel".






